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Preface

Objectives
This guide describes how to use the ShoreTel Contact Center supervisor applications: 
ShoreWare Agent Manager, ShoreWare Contact Center Reports, and ShoreWare Wallboard 
Director. It is intended for call center supervisors.

Documentation Overview
The following documents offer additional information about the Contact Center system:

• Release Notes

• Installing Guide

• Contact Center Administrator Guide

• Applications Interface Guide

• Installing and Implementing Enterprise Contact Center Chat

• Using Reports

• Using ShoreWare Agent Toolbar

• Context-Sensitive Online Help

Contact Center documentation can be found in the Documentation folder of the ShoreTel 
Contact Center Solution Installation CD and on the ShoreTel web site. The context-
sensitive online help can be accessed from the Help menu of each Contact Center 
application.

Document Conventions
The following conventions are used in this guide:

• Data-entry fields, hypertext links, control buttons, keywords, and other items 
within the system management interface are in a boldface font.

• Information that you enter in data fields are in a data_entry font.
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C H A P T E R 1

Overview

ShoreTel Contact Center includes three applications for supervisors. Using these 
applications you can monitor Automatic Call Distribution (ACD) activities, generate 
reports that summarize past performance, and display messages on wallboards. Multiple 
supervisor workstations can be activated simultaneously, allowing a number of supervisors 
and managers to work on various tasks at the same time. 

ShoreWare Agent Manager
ShoreWare Agent Manager is used by managers and supervisors to obtain real-time 
statistical information concerning contact center activities. The information can be 
displayed in tables, forms, and graphic formats, providing a clear picture of what is going 
on in your contact center.

ShoreWare Agent Manager also enables supervisors to adjust their resources by adding or 
removing agents from groups.

ShoreWare Contact Center Reports
ShoreWare Contact Center Reports generates historical statistical reports that you can use 
in evaluating past activities and planning future actions. The application contains a variety 
of predefined reports that can be quickly generated. In addition, you can create reports 
based on an extensive set of easily customizable templates.

ShoreWare Wallboard Director 
ShoreWare Wallboard Director is used to control the messages displayed on external and 
desktop wallboards. Messages can be made up of both free text and statistical parameters. 
Free sequences can be defined as a scenario or as popup messages and sent automatically.

Starting the Supervisor Applications
Each Contact Center supervisor application is started separately.

Note that Contact Center supervisor applications should not be used with the following 
Windows Power Schemes: Turn off hard disks, Sytem standby, System hibernates. These 
options should be set to Never. This is because the ECC Server and the Supervisor 
applications are synchronized every night at midnight. If your computer is in one of these 
Power Schemes, the synchronization will fail. To change your Windows Power Schemes, 
from your Desktop right-click. Select Properties from the resulting menu. In the Display 
Properties window, select the Screen Saver tab. Click Power. Change the options to Never, 
and click OK. 
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Starting ShoreWare Agent Manager
Step 1 From the Windows desktop, click Start > All Programs > ShoreTel > ShoreWare 

Contact Center Supervisor > ShoreWare Agent Manager.

If the ShoreWare Agent Manager icon is on your desktop, or in the Windows Start 
menu, you can click this icon to start ShoreWare Agent Manager.

Step 2 If this is your first time logging into ShoreWare Agent Manager, you are asked to 
specify your ECC server, and then click OK.

If you are using a redundant server, a message is displayed indicating that the 
system is automatically being configured for redundancy. Click OK to close the 
message.

Step 3 In the ShoreTel Contact Center Logon window, specify your login name, password, 
and server IP address, and then click OK.

If your server is not listed in the drop-down menu, click Servers to add the server 
to the list. Use the resulting dialog box to add and remove servers from the list and 
to specify the default server.

Once connected to the server, ShoreWare Agent Manager opens.
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Starting ShoreWare Contact Center Reports
Step 1 From the Windows desktop, click Start > All Programs > ShoreTel > ShoreWare 

Contact Center Supervisor > ShoreWare Contact Center Reports.

If the ShoreWare Contact Center Reports icon is on your desktop, or in the 
Windows Start menu, you can click this icon to start ShoreWare Contact Center 
Reports.

Step 2 If this is your first time logging into ShoreWare Contact Center Reports, you are 
asked to specify your ECC server, and then click OK.

If you are using a redundant server, a message is displayed indicating that the 
system is automatically being configured for redundancy. Click OK to close the 
message.

Step 3 In the ShoreTel Contact Center Logon window, specify your login name, password, 
and server IP address, and then click OK.

If your server is not listed in the drop-down menu, click Servers to add the server 
to the list. Use the resulting dialog box to add and remove servers from the list and 
to specify the default server.

Once connected to the server, ShoreWare Contact Center Reports opens.
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Starting ShoreWare Wallboard Director
Step 1 From the Windows desktop, click Start > All Programs > ShoreTel > ShoreWare 

Contact Center Supervisor> ShoreWare Wallboard Director.

If the ShoreWare Wallboard Director icon is on your desktop, or in the Windows 
Start menu, you can click this icon to start ShoreWare Wallboard Director.

Step 2 If this is your first time logging into ShoreWare Wallboard Director, you are asked 
to specify your ECC server, and then click OK.

If you are using a redundant server, a message is displayed indicating that the 
system is automatically being configured for redundancy. Click OK to close the 
message.

Step 3 In the ShoreTel Contact Center Logon window, specify your login name, password, 
and server IP address, and then click OK.

If your server is not listed in the drop-down menu, click Servers to add the server 
to the list. Use the resulting dialog box to add and remove servers from the list and 
to specify the default server.

Once connected to the server, ShoreWare Wallboard Director opens.
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C H A P T E R 2

Monitoring Activity

ShoreWare Agent Manager provides real-time statistical information, and management 
tools, to inform you about the situation in your contact center and manage its agents.

ShoreWare Agent Manager Menu Bar
The ShoreWare Agent Manager menu bar contains the following menus:

• File - Used to create new report windows, open or close report windows, save report 
windows, save workspaces, and exit ShoreWare Agent Manager. 

• Contents - Provides commands to add, remove, change, or reorder information in the 
current real-time window. This menu is available only after a real-time report is 
opened. 

• Tools - Used to set the refresh rate time interval.

• Windows - Includes commands to arrange the ShoreWare Agent Manager window and 
switch between windows currently open.This menu is available only after a real-time 
report is opened.

• Help - Provides access to the ShoreWare Agent Manager context-sensitive online Help.

File Menu

The File menu provides the following commands:

• New - Open a new real-time report template.

• Open - Open an existing real-time report.

• Close - Close the currently active real-time report window.

• Save - Save the real-time report in the currently active window under its current name.

• Save As - Save the real-time report in the currently active window with a new name.

• Workspace - The ShoreWare Agent Manager workspace defines the place and order of 
the reports. Every supervisor in the system has a personal workspace.

— Save As Default - Saves the current workspace area as the default.
— Restore Default- Restores the default workspace layout.

• Logout and Exit - Exit ShoreWare Agent Manager and all other currently used 
Supervisor applications.

• Exit - Exit ShoreWare Agent Manager.
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Contents Menu

The Contents Menu provides the following options: 

• Add - Add an entry to a report. This command applies to multiple entity templates, 
such as Brief Group Report, Group Queued Calls Graph, Daily Summary Brief Group 
Report, and Trunk Group Status.

• Remove - Remove an entity from a report. This command applies to multiple entities 
templates, such as Brief Group Status, Group Queued Calls Graph, Daily Summary 
Brief Group Report, and Trunk Group Status.

• Change - Change the current entity in the report. This command applies only to single 
entity templates, such as Detailed Group Status and Trunk Group Trunks Status.

• Reorder - Choose a sort key for entries in the current report. This command applies 
only to tables. 

Tools Menu

The Tools Menu provides the following option: 

• Refresh Rate - The refresh rate defines how often ShoreWare Agent Manager requests 
an update from the server. By default, the refresh rate is one second. 

— Automode - In this mode of operation, ShoreWare Agent Manager senses the 
network throughput and changes the refresh rate accordingly. 

— Manual Mode - In this mode of operation, you can set any refresh rate for 
ShoreWare Agent Manager. However, if the network throughput is low, ShoreWare 
Agent Manager may not be able to receive the information at a quick rate, resulting 
in a higher refresh rate.

Graphical Reports Toolbar
The Graphic Toolbar is displayed at the top of most graphical report windows.

The features on the Toolbar are used to change the way a graphical report is displayed. 
These are: 

• Palette Selector (1) - Change the color scheme based on predefined palettes. 

• Points Labels (2) - Show or hide the labels for the points of the graph.

• Legend Box (3): Show or hide the legend.

Not all the features available from the Toolbar are applicable to all graphical reports. Those 
not available for a specific report are grayed out. 
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Agent Management 

Login Manager
The Login Manager enables you to change the group assignment of agents currently 
working in the contact center. The Login Manager has two optional views: Agent Login 
Status and Group Login Status. In the Agent Login Status view, you can view an agent’s 
current group assignment. You can then add or remove groups to and from the agent. The 
Group Login Status view allows you to view the agents currently logged into a specific 
group. You can then add or remove agents to and from the group.

To open the Login Manager, do one of the following:

• Click the Login Manager icon on the Toolbar.

• Right-click a report based on the Group Agents Report or Brief Agent Report templates, 
and then select Login Manager from the popup menu.

The Agents Login Status tab comprises:

• Agents - Lists all agents currently logged into the system.

— Name - The name of the agent
— Number - The ID number of the agent

• Logged-in Groups - Lists the groups that the selected agent is currently logged into.

• Available Groups - Lists the groups that the agent is currently not logged into.

The Groups Login Status tab comprises:

• Groups - Lists all groups defined in the system.

• Logged-in Agents - Lists the agents currently logged into the selected group.

• Available Agents - Lists the agents currently not logged into the selected group, but 
logged into at least one other group.
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Creating New Reports 

To create a new report:

Step 1 From the File menu, click New. You can also click the New icon on the Toolbar. 

The New dialog box appears.

Step 2 From the Report Type drop-down list, click the report type you want. 

Step 3 Select the template from the Template Name list, and click OK.

The appropriate New Entity dialog box appears.

Step 4 To sort the entity list by name or by number, click the title. 

Step 5 Select the required new entity, and click OK. 

The selected Report window appears. The window title bar indicates that the report 
is untitled, and displays the name of the template on which the report is based. 

Any current activity in the ACD is immediately reflected in the report. 
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Opening Predefined Real-Time Reports 

To open a predefined real-time report:

Step 1 From the File menu, click Open. You can also click the Open icon on the Toolbar. 

The Open dialog box appears.

Step 2 To narrow the list of reports displayed, select Public or Private (both options can be 
selected), and from the Report Type drop-down list, select the report type. 

Step 3 Select the report to open, and click OK. 

Saving Real-Time Reports 
A report can be saved in both the public and private report lists. All authorized supervisors 
can view public reports, but only you who created them can view private reports. 

To save a real-time report:

Step 1 To save a report with its current properties, from the File menu, click Save. You can 
also click the Save icon on the Toolbar. 

If the current report has not yet been saved, the Save button is disabled.

Step 2 To save a report under a different name, or to save a private report as public (or the 
reverse), from the File menu, click Save As. You can also click the Save As icon on 
the Toolbar. 

The Save As dialog box opens.

Changing the Entity in the Current Window 
This action applies only to reports related to one entity. 

To change the entity in the current window:

Step 1 From the Contents menu, click Change. You can also click the Change icon on the 
Toolbar. 
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The Change Entity dialog box appears, showing the list of entities not yet included 
in the report. 

Step 2 The entity list can be sorted by name or by number by clicking the title. 

Step 3 Select the entity that you want the report to be based on. 

Step 4 Click OK. 

Adding Entities to Reports 
This action applies only to reports that allow you to see more than one entity at a time. For 
a detailed list, see page 19.

To add an entity to a report:

Step 1 From the Contents menu, select Add. You can also click the Add icon on the 
Toolbar. 

The Add Entity dialog box appears with the list of entities not already in the report.

Step 2 The entity list can be sorted. 

Step 3 Select the entity to be added to the report. 

Step 4 Click OK. 
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Removing Entities from Reports 
This action applies only to reports that allow you to see more than one entity at a time.

To remove an entity from a report:

Step 1 From the Contents menu, click Remove. You can also click the Remove icon on the 
Toolbar. 

The Remove Entity dialog box appears, with the list of entities in the report. 
displayed.

Step 2 The entity list can be sorted. 

Step 3 Select the entity to be removed from the report. 

Step 4 Click OK. 

Reordering the Current Report 
Tabular reports can be customized by changing the order of the entities. Entities may be 
sorted by name, by number, or by extension number.

The By Extension check box does not appear for trunk and group reports. 

To reorder the current report:

Step 1 From the Contents menu, click Reorder. You can also click the Reorder icon on the 
Toolbar. The Reorder dialog box appears.

Step 2 Select the desired sort criteria. 

Step 3 Click OK. 

The report entries are reordered according to your selection. 
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Changing Column Order in Tabular Reports 

To change the column order:

Step 1 Click the header of the column that should be moved.

Step 2 Drag it to its new location.

The column is moved to its new location. 

Adding / Removing Columns in Tabular Reports 

To add or remove columns:

Step 1 Click the Add/Remove Columns icon on the ShoreWare Agent Manager toolbar. 

The Add/Remove Columns dialog box appears.

Step 2 Perform one of the following:

• Select the required columns in the Available Columns list, and click the Add 
button to add them to a report.

• Select the required columns in the Visible Columns list, and click the Remove 
button to remove them from a report.

Step 3 Click OK. 

Changing the Refresh Rate
The refresh rate defines how often the ShoreWare Agent Manager requests an update from 
the server. By default, the refresh rate is one second.
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Available Report Types in ShoreWare Agent Manager
For information on using these reports, see the Using Reports guide.

Report Name Type + / - Entity Change Reorder
Daily Brief Email Group Report Daily X X

Daily Brief Group Report Daily X X

Daily Detailed Email Group Report Daily X

Daily Detailed Group Report Daily X

Daily Detailed Super Group Report Daily X

Group Hourly Report Hourly X

Agents Needing Help Real Time X

Agents Distribution Graph Real Time X

Brief Agents Report Real Time X X

Brief DNIS Report Real Time X X

Brief Email DNIS Report Real Time X X

Brief Email Group Report Real Time X X

Brief Group Report Real Time X X

Brief IVR Applications Report Real Time X X

Brief Mailbox Report Real Time X X

Calls Distribution Graph Real Time X

Detailed Email Group Report Real Time X

Detailed Group Report Real Time X

Detailed IVR Applications Report Real Time X

Detailed Super Group Report Real Time X

Email Contacts Distribution Graph Real Time X

Email Group Overflow\Interflow Report Real Time X

Email Group Queue Contacts Graph Real Time X

Email Group STI Graph Real Time X

Graphical Agents Report Real Time

Group Agents Report (1) Real Time X X

Group Agents Report (2) Real Time X X

Group OACD STI Graph Real Time X

Group Overflow\Interflow Report Real Time X

Group Queued Calls Graph Real Time X
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Group Queued OACD Calls Graph Real Time X

Group STI Graph Real Time X

IVR Applications ACD Distribution Graph Real Time X

IVR Applications Active ACD Graph Real Time X

IVR Applications Active OACD Graph Real Time X

IVR Applications OACD Distribution 
Graph

Real Time X

IVR Group IVR Ports Report Real Time X X

IVR Ports Distribution Graph Real Time X

IVR Ports Report Real Time X X

Staffing Graph Real Time

Staffing Percent Graph Real Time

Staffing Percent Report Real Time

Staffing Report Real Time

Trunk Group Report (1) Real Time

Trunk Group Report (2) Real Time

Trunk Group Trunks Report (2) Real Time

Trunk Group Trunks Report(3) Real Time

Report Name Type + / - Entity Change Reorder
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C H A P T E R 3

Analyzing Trends

Historical reports are used to obtain information about past Contact Center activity. The 
powerful, yet easy to use, Contact Center Historical Reports application provides activity 
summaries and statistical data that can help you analyze system behavior and aid in the 
assessment of resources required to meet target service levels.

Historical data is presented in report windows. The reports are generated from categories 
and templates that can be configured to include specific columns and entities, as required. 

Historical Reports are essential for proper call system management. Analyzing system 
performance based on past activity ensures that problems can be detected and solved and 
that the system efficiency is improved. 

Each template can be generated in tabular or graphical format. You have full control over 
texts, fonts, colors, column widths, and even column locations, with minimal mouse and 
keyboard actions.

Additional powerful tools (such as sorting by columns, filtering of data by user-defined 
criteria, defining of noncontinuous period reports, and so on) are provided to support a 
comprehensive and flexible environment for generating sophisticated reports that do not 
require a manager to know about database tables, SQL queries, or programming languages.

An integrated scheduler enables automated reports to be printed at required times or to be 
exported to a file.

After a report is generated, it can be exported in a variety of external formats, such as Excel, 
HTML, SQL, and others. 

Contact Center Historical Reports can contain the following types of information: 

• Specific Lists - Lists that can be used to improve the professional activities of the 
Contact Center. Some examples: 

— Abandoned Calls Log - Abandoned calls by Automatic Number Identification 
(ANI), allowing customer call back.

— Trunks Exception Log - Trunks whose utilization was below a certain threshold 
(defined in the Administration application), allowing an immediate decision as to 
whether trunks can be released to decrease expenses.

— Outbound and Dial Lists - Details every outbound call dialed by the system.

• Activity Summary - Summarization of past system activity, such as number of 
incoming calls at a specific date and time, and number of agents logged in at a specific 
date and time.

• Statistical Analysis - Statistical information regarding the system’s behavior over a 
specific period of time, including average talk times, average wait times, and percentage 
calculations.
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• Advanced Analysis - Statistical information that estimates the amount of resources that 
should have been allocated to meet a service level goal—for example, the number of 
agents required to meet the target Average Speed of Answer (ASA) during a specific 
period.

In addition, the you can select the following report summary types: 

• Vertical summary (daily interval summary or period interval average) - Each line 
represents the summation of specific time periods within the entire report period. 

• Horizontal summary (interval summary per day) - Each line represents the summary 
of a day within the entire report period. 

Based on the types of reports described earlier and the flexibility of Historical Report 
design, a large variety of data can be obtained to provide management with an accurate, 
operational view of the call system. 

The Historical Reports application can display the following three window types:

• Categories - Basic templates that set the entity on which the template is based (an 
entity can be a group, agent, ANI domain, and so on) and the summary type (Vertical 
vs. Horizontal). There are no data columns in the categories and no parameters (for a 
detailed list of the categories, see the section Report Categories on page 40). 

• Templates -Templates based on category, that are either supplied with the product 
(factory templates) or created by the user (user-defined templates). A template can 
contain data columns, can contain some, or all, of the required parameters, and can be 
generated to report. For a detailed list of the Factory Templates, see page 40.

• Reports - Generated reports that contain statistical data.

Main Window
In the main window, the Report and Window menus are displayed only when a report has 
been opened.

• File - Create new report windows, open or close report windows, save report windows, 
print a report, export a report to a file, open the Scheduler dialog box, and exit the 
Historical Reports application. 

• Report - Available only after a report window is opened on the screen. Use to open the 
parameters dialog box, to generate a report, to schedule a report to be automatically 
generated, and to set the graph type in graphical reports. 

• Tools - Add sort criteria to a report, to add a filter criteria to a report, to change the 
zoom of a report, and to open the Formula Editor dialog box.

• Windows - Available only after a report window is opened on the screen. Use to 
arrange the Historical Reports windows and to switch between currently open 
windows.

• Help - Open context-sensitive online Help.
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File Menu

The File menu offers the following options:

• New - Opens a new template window based one of the categories.

• Open - Opens an existing historical template.

• Save - Saves the currently active template under its current name.

• Save As - Saves the currently active template under a new name.

• Export - Opens the Export dialog box, used to export an active report to a file.

• Schedule List - Opens the Scheduler dialog box, which enables you to view, change, 
and delete items on the list of scheduled reports. Clicking the Log button provides 
information on the outcome of the scheduled report.

• Printer Setup - Opens the Printer Setup dialog box.

• Print - Prints the currently active report. 

• Close - Closes the currently active report window.

• Logout - Logs you out of the Historical Reports application.

• Exit - Exits the Historical Reports application.

Report Menu

The Report menu supplies the following options: 

• Parameters - Opens the Parameters dialog box for the active template window.

• Generate - Generates the report in the currently active template window. If the 
template is missing one of the parameters, the Parameters dialog box opens. 

• Schedule - Opens the Automatic Reports dialog box to set the required parameters to 
automatically generate the currently active report window.

• Graph Type - Sets the graph type for the currently active graphical report. It is enabled 
only if the currently active window is a graphical report.

Tools Menu

The Tools menu furnishes the following options:

• Sort - Clears the currently defined sorting criteria (if the Clear option is selected) or 
opens the Sort dialog box to Add or Change the sorting criteria. The sorting criteria can 
be defined for a template (and is then saved with the template), or for a report (which 
is not saved when the report is closed).

• Filter - Clears the currently defined Filter (if the Clear option is selected) or opens the 
Filter dialog box to Add or Change the filter criteria. The filter criteria can be defined 
for a template (and is then saved with the template), or for a report (which is not saved 
when the report is closed).

• Zoom - Relevant to report windows only. It opens the Zoom dialog box that enables 
you to change the report window sizing.

• Formulas Editor - Opens the User Defined Formulas dialog box.
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Windows Menu

The Windows menu contains the following options:

• Layer - Maximizes the currently open window

• Tile - Arranges all open windows one over the other

• Cascade - Arranges all open windows in a cascade

Creating a New Template

To create a new template:

Step 1 From the File menu, click New. You can also click the Create New Template icon 
on the Toolbar. 

The New dialog box appears.

Step 2 Select the category from the list and click OK. 

The selected category window appears.
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Opening a Template

To open a template:

Step 1 From the File menu, click Open. You can also click the Open Existing Template 
icon on the Toolbar.

Step 2 The Open dialog box appears.

.

Step 3 Select the Public check box, or the Private check box, or both to display the desired 
templates. 

Step 4 Select the report to open, and click OK.

Saving a Template
A template can be saved in two lists: the public templates list, and the private templates list. 
All authorized supervisors can view public templates, but only you who created private 
templates can view them.

To save a template:

Step 1 To save a template with its current properties, from the File menu, click Save 
option. You can also click the Save Template Definition icon on the Toolbar.

If the current template has not yet been saved, the Save As dialog box opens.

Step 2 To save a template under a different name, or to save a private template as public 
(or the reverse), click Save Template Definition With a New Name from the File 
menu. You can also click the Save As icon on the Toolbar

The Save As dialog box opens.
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Exporting a Report
A report can be exported to a file in various formats. 

Note that if you want to export the report to PDF, your administrator has to first installed a 
required component on your machine. If you are unable to export reports to PDF, contact 
your administrator.

If you are exporting to the XLS format, before beginning the export process make sure to 
widen the first column in the report template. This will ensure that the subtotals in that 
column are displayed.

To export a report:

Step 1 From the File menu, click Export Report Content. You can also click the Export 
Report Content icon on the Toolbar.

Step 2 Use the Choose a File Name window to specify the location, name, and type of the 
report. 

Step 3 From the Report Export Parameters window, confirm the name, location, format 
and options of the report. 

Clicking Browse opens the Choose a File Name window. From this window, you 
can navigate to the folder in which the exported file will be kept, give it a name, 
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and choose the export format. The window displays the folder tree on the Contact 
Center server, under the root folder in which the Contact Center server software is 
installed.

Depending on the type of file format you selected, three more options may become 
available: Append Report Parameters, Append Total Rows, and Append Subtotal 
Rows to the exported file.

Step 4 Click Export Data.

The report is exported in the format, and with the name and in the location you 
specified.

Scheduling a Report for Automatic Generation
A report can be scheduled for automatic generation in order to automatically print, export, 
or email the report.

The supported export file formats for ShoreWare Contact Center 5.1 and onwards 
historical reports are:

• Comma-Separated Values (.CSV)

• Enhanced Metafile Format (.EMF)

• Microsoft Excel (.XLS)

• Portable Document Format (.PDF)

• SQL Syntax (.SQL)

• Text with HTML Formatting (.HTM)

The following export file formats are no longer supported:

• dBASE format (.DBF)

• Data Interchange Format (.DIF)

• Powersoft Report format (.PSR)

• Microsoft Multiplan format(.SLK)

• Tab-separated columns (.TXT)

• Lotus 1-2-3 format (.WKS)

• Windows Metafile format (.WMF)

Existing historical reports scheduled to be exported into the WMF format will be 
automatically converted to Enhanced Metafile Format (.EMF); all other non-supported file 
formats will be converted to the Comma-Separated Values (.CVS) format.

To schedule a template:

Step 1 From the Report menu, click Schedule. You can also click the Define an Automatic 
Report icon on the Toolbar.

The Automatic Reports window opens.



Supervisor User Guide Chapter 3: Analyzing Trends 

28

Step 2 In the Schedule tab, specify the schedule name and options. 

The schedule name appears in the schedule list. To keep the new schedule up-to- 
date with any changes made to the template on which it is based, select the 
Synchronize with the source template (parameters, design) check box.

Use the options in the Date and Time areas to identify when the report is to be 
generated. For example, to generate a report every week on Sunday at 8:00 P.M., 
click Every Week from the drop down list, and select Sunday as the day of week. In 
addition, select the Specific time check box, and then use the up/down arrow to 
select 8:00 P.M.

Step 3 If you want to generate the report to a printer, from the Destination tab check 
Printer. Then select the appropriate printer options.

By default, the report is sent to your default printer. To select a different printer 
from the list defined in the Contact Center server, click Browse. You can choose the 
report page orientation from the Orientation area. The Default option uses the 
specified printer’s default orientation. 
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Step 4 If you want to generate the report to a file, from the Destination tab check File. 
Then select the appropriate file options.

.

These options are:

Destination

• File Path - The location the file is to be saved on the Contact Center server. 
Click Browse to navigate to and select a location.

• Base File Name - By default, the report is saved with the name of the schedule. 
You can change the report name or restore the default name.

• Full File Name - Include here the file extension.

Format

• Type - The file format type of the report. Note that if you want to export the 
report to PDF, your administrator has to first installed a required component on 
your machine. If you are unable to export reports to PDF, contact your 
administrator.

• Available Options - Depending on the type of file format you selected, three 
type options may become available: Append Report Parameters, Append Total 
Rows, and Append Subtotals.

File Name Manipulation

• Append Date/Time - Adds the date and/or time to the file name.

• Format - If the Append Date/Time option is checked, select the date and time 
format you want to use. 

• Suffix - If Suffix is selected, the system adds the suffix entered in the edit box at 
the end of the file name.
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• Keep- Defines how many copies of the same file are kept. If a file with the same 
name is generated (for example, if Suffix was selected but Append Date/Time 
was not selected), the system renames the previous file by adding the 
generation number to the name. If the generation number is exceeded, the 
system removes the oldest copy.

Email

• Email Report - Checking Email Report sends the report as an email attachment.

• Delete File After Sending - If checked, after the email is sent the report file is 
automatically deleted from your machine.

• To - The address(es) the report is to be sent to.

• From - The address the report will be sent from.

• Subject -The subject of the email.

• Append Date/Time - Appends the date and time of the email to the subject line.

• Format - If the Append Date/Time option is checked, select the date and time 
format you want to use.

• Append Report Name - Appends the report name to the email subject line.

• Resulting Subject Text - Displays the subject line of the email based on the 
specified options.

Step 5 Click OK.

The report will be automatically generated with the options you specified.

Viewing the Scheduled Templates List

To view the list of the scheduled templates:

Step 1 From the File menu, click Schedule List. The Schedule List dialog box opens.

Step 2 To change the schedule parameters, select the schedule to change from the list, and 
click Edit. 

The Automatic Reports window opens (for details, see Scheduling a Report for 
Automatic Generation on page 27).
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Step 3 Click Delete to remove a schedule from the list. 

This action does not remove the template on which the schedule is based.

Step 4 Click Log to get information on the outcome of the scheduled report.

Adding a Filter to a Template or Report
Sometimes, you may need to omit some of the records in the report according to some 
criteria (for example, a supervisor generates a Group Performance by Interval report but 
needs to see only those intervals of the average number of logged in agents less than some 
number), For this purpose, you may add a filter to the template.

Filters can be added to a report as well, but they cannot be saved. Filters added to a 
template are saved along with the template itself.

To add a filter to a template or report:

Step 1 From the Tools men, select Filter > Change. The Filter dialog box appears.

Step 2 From the drop down list, click one of the columns in the template that will be used 
to filter the report.

Step 3 Select the operator and the value to complete the condition. For example, in the 
operator field, select greater than, and in the value field, select 10. This means that 
the report generated from the filtered template shows only intervals in which the 
group’s Cmltv Idle Time is greater than 10 seconds.

Step 4 If more conditions are required, add a condition line to the filter by clicking Add. 
In such a case, a logical operator must be selected.

Step 5 To delete one of the conditions, click the condition (the finger icon moves to point 
to the selected condition) and click Delete.

Step 6 Click OK to accept the filter or Cancel to cancel the operation. 

Step 7 To remove a filter from a template or report, from the Tools menu, select Filter > 
Clear. 

In filtered reports, although some records are filtered out, the “total” line calculates the 
totals as if those filtered records were part of the report. To view a total line that reflects the 
report as is, export it and use the source application to calculate the totals without the 
filtered records.
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Sorting a Template or Report
Occasionally, there is a need to arrange the records in the report according to particular 
criteria (for example, a supervisor generates a group performance by interval report and 
needs to see the intervals in ascending order by the average number of logged in agents). 
For this purpose, a supervisor can add sort criteria to the template.

Sort criteria can be added to a report as well, but they are not saved with the report. Sort 
criteria added to a template are saved along with the template itself.

To sort a template or report:

Step 1 From the Tools menu, select Sort > Change. The Sort dialog box appears.

In the Sort dialog box, the Columns available for sorting list contains all the 
columns in the template not yet part of the sort criteria. The Sort columns list 
contains all the columns by which the report should be sorted. 

Step 2 To add a column to the sort criteria, drag and drop it to the Sort Columns list.

Step 3 To remove a column from the sort criteria, drag and drop it to the Columns 
available for sorting list.

Step 4 Select the Ascending check box if you would like the column order to be 
ascending.

Creating a User Defined Formula
The Historical Reports application has a rich set of columns that can be added to templates. 
However, there may be a need to add a user defined formula to a list of columns that can be 
added to a template. 

To add a user defined formula:

Step 1 To open the User Defined Formula dialog box, from the Tools menu, click 
Formulas Editor.
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Step 2 Select the formula to change, or click New to add a new formula to the list. 

The Specify Formula dialog box opens.

The followings options are available

• Name - Give a name to the new formula. This name appears in the list of 
available columns when adding a column to a template. Note that the list of 
available columns is shown per entity. You must set an entity for each user 
defined formula.

• Description - Give a description to the new formula. When you are adding 
columns to a template, and when you are selecting a column name from the 
list, the description is displayed below to inform you of the column’s purpose. 

• Formula - Here you define the new formula. The formula is a combination of 
predefined statistical data that appear in the Columns section. It lists factory 
formulas as well as other user defined formulas. It also lists mathematical 
operators on the right-hand side of the dialog box. Available operators are 
addition (+), subtraction (–), multiplication (*), and division (/). To add a 
column or operator to the list, click the relevant column name or math 
operation icon. You can also edit the formula area directly by typing the proper 
symbols.

• Entity - Select from this list the entity for the new formula. Because this option 
dictates the available columns that are part of the formula (you cannot combine 
in one formula columns of more than one entity), it cannot be changed when 
editing an existing formula.

• Formula type - Because there are few internal operators that format the result 
according to the expected result, you must set the formula type.

• Verify - Click this button to ensure that the formula is valid.

• Save - Click this button to save the formula under its current name.

• Save As - Click this button to save the formula under a different name.
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Designing a Template

To design a template, you can:

• Change the headers (text, font, and color)

• Add columns to the template, remove columns from the template, and reorder the 
columns

• Define the template parameters

A template has four areas, each with a different set of options. Click any area to 
display a pop-up menu with the relevant design options.

• Area A - The options in this area modify the way in which the template name is 
displayed (in the preceding example, changing the RG1.2 Group Performance Report 
by Date).

— Text - Use this option to change the text of the template name.

— Font - Use this option to change the font of the template name.

— Color - Use this option to change the color of the template name.

• Area B - The options in this area modify the way in which the parameter names are 
displayed (in the preceding example, changing the Date From/Date To, Time From/
Time To, Group Name, and Request By parameters).

— Text - Use this option to change the text of the parameter name.

— Font - Use this option to change the font of the parameter name.

— Color - Use this option to change the color of the parameter name.

— Frame - Use this option to define the appearance of the frame around the 
parameter. The options are None (if no frame is required), Box (if a normal frame is 
required), and Raised (if a shaded border frame is required).
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• Area C - The options in this area modify the way in which the parameters are 
displayed. 

— Font - Use this option to change the font of the parameters.

— Color - Use this option to change the text color of the parameters. 

— Frame - Use this option to define the appearance of the frame around the 
parameter. The options are None (if no frame is required), Box (if a normal frame is 
required), and Raised (if a shaded border frame is required).

— Parameters - This option opens the Parameters dialog box. This dialog box is 
template sensitive (that is, it may look different for different templates).

This dialog box may include one or more of the following:

❋ An option to define the date range.

❋ An option to define the time range.

❋ An option to select entities on which the report will display the data. In some 
templates, you can choose only a single entity; in others, you can choose 
multiple entities.

• Area D - Some options in this area modify the display of column headings; others 
define the data to be displayed in the report.

— Text - Changes the heading text of the column to which the cursor is pointed.

— Font - Changes the column heading font of all the columns. You cannot change a 
specific column’s heading font.

— Color - Changes the column heading text color of all the column headings. You 
cannot change a specific column’s heading text color.

— Number Header Rows - Defines the number of rows for the column’s headings. Use 
multiple rows to prevent truncating long column headings—often, the column 
width is limited so that many columns can fit in the template.

— Insert Column - Opens the Insert Column dialog box. 

— Delete Column - Removes the selected column from the template.

— Grid Lines - Toggles the grid line display.

— Changing the column’s width - This option is not in the pop-up menu. To change 
column width, click the left-hand border of the column, drag it to the required 
width, and release the mouse button.

Using the Advanced Date Options
The Advanced Date options enable you to generate reports on specific dates within the date 
range. This option is available only when the Date From and Date To in the Parameters 
dialog box are both specific dates.

To use the Advanced Date option:

• To open the Parameters dialog box, right-click in Area C of the template (see the 
section Designing a Template on page 34), and select Parameters from the pop-up 
menu, or use the toolbar icon.
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The contents of the parameters dialog box can vary according to the current template, 
although all dialog boxes have the Date From and Date To section.

• To open the Date dialog box, click either the Date From or Date To section in the 
Parameters dialog box.

The followings options are available:

• Clear: Click this option to clear the Date From/Date To from the previous selection.

• Now: Use this option to set a relative date. When this option is selected, use the spin 
box to the right to define the number of working days. When the report is generated, 
the system calculates the From/To Date as the current date minus the defined number 
of days.

This option is useful when you want to use the template as a scheduled report.

• Specific: Use this option to set a specific date. Use the calendar to the right to set the 
required date.

When both Date From and Date To are defined as Specific, the Advanced button is 
enabled. Click this button to open the advanced options.
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The following options are available:

• Advanced Property: Use this button to select between two options: Date Ranges and 
Specific Days. In Date Ranges mode, add date ranges. In Specific Days mode, select the 
days of the week for which the main date range is relevant. 

• Date Ranges Mode:

— Add: Adds a new Date Range at the end of the list

— Insert: Inserts a new Date Range before the currently selected Date Ranges

— Delete: Removes the selected Date Range

• Specific Days Mode: Click the buttons for the days of the week that should be included 
in the report.

Using the Advanced Time Options
The Advanced Time options enable you to generate a report that includes a time range. 
This option is available only when both the Time From and Time To in the Parameters 
dialog box are specific dates.

To open the Parameters dialog box:

• Click in Area C of the template (refer to the section Designing a Template on page 
34), and from the pop-up menu, click Parameters. Alternatively, you can use the 
toolbar icon. 

The parameters dialog box can vary according to the current template, although all 
dialog boxes contain the Time From and Time To sections.
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To open the Time dialog box:

• Click either the Time From or Time To section in the Parameters dialog box.

The followings options are available:

• Clear - Click this option to clear the Time From/Time To from the previous selection.

• Now - Use this option to set a relative time. When this option is selected, use the spin 
box to the right to define the relative time (in hh:mm format). When the report is 
generated, the system calculates the From/To Time as the current time minus the 
defined relative time.

This option is useful when the template will be used as a scheduled report.

• Specific: Use this option to set a specific time. Use the spin box to the right to set the 
required time.

When both Time From and Time To are defined as Specific, the Advanced button is 
enabled. Click this button to open the advanced options.
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The following options are available:

• Date Ranges Mode

— Add - Adds a new Time Range at the end of the list
— Delete - Removes the selected Time Range

Provided Templates
• RA1.1 Agent Performance Report by Interval
• RA1.2 Agent Performance Report by Date
• RA2.1 Group Agents Performance Report
• RA2.2 Super Group Agents Performance Report
• RA3.1 Agent Activity Log Report
• RG1.1 Group Performance Report by Interval
• RG1.2 Group Performance Report by Date
• RG2.1 Group Staffing Report by Interval (Enterprise Only)
• RG2.2 Group Staffing Report by Date (Enterprise Only)
• RG3.1 ACD Calls Distribution by Interval
• RG3.2 ACD Calls Distribution by Date
• RG4.1 Abandoned Calls Analysis by Interval
• RG4.2 Abandoned Calls Analysis by Date
• RG5.1 Detailed Group Wrap-Up Report by Interval
• RG5.2 Detailed Group Wrap-Up Report by Date
• RG6.1 Group Wrap-Up Code Report
• RG7.1 Abandoned Calls Log
• RS1.1 Super Group Performance by Interval
• RS1.2 Super Group Performance by Date
• RS2.1 ACD Calls Distribution by Interval
• RS2.2 ACD Calls Distribution by Date
• RS3.1 Abandoned Calls Analysis by Interval
• RS3.2 Abandoned Calls Analysis by Date
• RT1.1 Trunks Usage Report by Interval
• RT1.2 Trunks Usage Report by Date
• RT2.1 Trunking Report by Interval
• RT2.2 Trunking Report by Date
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Report Categories
• 1.1 Group by Interval
• 1.2 Group by Date
• 2.1 Super Group by Interval
• 2.2 Super Group by Date
• 3.1 Agent by Interval
• 3.2 Agent by Date
• 3.3 Group Agent by Interval
• 3.4 Group Agent by Date
• 3.5 Super Group Agent by Interval
• 3.6 Super Group Agent by Date
• 3.7 Agent Groups by Interval
• 3.8 Agent Groups by Date
• 3.9 Agent Calls Distribution by Agent
• 4.2 Group Agents
• 4.3 Super Group Agents
• 5.1 Trunk Group by Interval
• 5.2 Trunk Group by Date
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C H A P T E R 4

Communicating with Agents

ShoreWare Wallboard Director enables you to communicate with entire groups of agents 
simultaneously, while providing you with important information instantaneously.

Using ShoreWare Wallboard Director, you can create and store new wallboard messages, 
modify existing messages, and customize messages for individual groups. You also can 
create customized scenarios, which may include messages and pop-ups. Pop-ups display a 
message at a specific time for predefined periods.

Contact Center supports single and two line LED Wallboards from Spectrum Corporation 
(www.specorp.com.) 

The ShoreWare Wallboard Director Main Screen
The ShoreWare Wallboard Director main screen is displayed after you have successfully 
logged onto the application. The main screen comprises a menu bar with menu options, 
and a toolbar with two tool icons that provide you with quick access to the most frequently 
performed procedures.

The toolbar provides the following functions:

• Wallboard (1) - Opens the Wallboard window.

• Logout (2): Exits ShoreWare Wallboard Director and any other currently open Contact 
Center supervisor applications.

Message Editor Window
The Message Editor window is used to create and edit messages to be displayed on the 
wallboard.

A new message can be created, or an existing one can be edited, using the following 
fields and buttons in the Message Editor:

• Message Library - Displays the messages available for use in the wallboard. Each time a 
new message is created, it is placed in the Message Library. The Message Library is 
displayed both in the Message Editor window and the Wallboard window in the same 
format. A message is not removed from the list after being added to a scenario, thereby 
enabling you to use any message an unlimited number of times.
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• Message Name - Shows the name of the selected message. When creating a new 
message, you must fill in this field. When modifying an existing message, you have the 
option to change the message name. The message name can contain a maximum of 32 
characters.

• Default Group - For parameters in a message, a group must be assigned to be 
displayed. The parameter’s group may be defined in various stages during the process of 
inserting a message into a scenario or a pop-up.

• Line 1 - Displays the first line of the selected message. This read-only area displays 
modifications made to the message in the work area of the Message Editor window. 
Each set of parentheses represents a parameter that has been included in the message.

• Line 2 - Displays the second line of the selected message. This read-only area displays 
modifications made to the message in the work area of the Message Editor window. 
Each set of parentheses represents a parameter included in the message.

• New - Click to create a new message. All the fields in the Message Editor are cleared, 
except for the Message Library. All the fields in the Message Editor must be filled in for 
a new message to be complete.

• Delete - Click to erase a selected message. A warning appears. Click Yes to delete the 
message or No to cancel the process.

• Cancel - Click to undo any changes you have made and return to the original message.

• Parameter - Click to open the parameter dialog box, in which you can select preset 
parameters from the Parameters list. Parameters selected from this list are included in 
the message.

• Message Area - Area to enter and edit messages.

Each box represents one character, and the paragraph marks represent parameters 
included in the messages. You can change the color of individual characters by right-
clicking their boxes. Each line has 40 characters, for a total of 80 characters. The two 
lines of the message area are not continuous. Therefore, a message that begins on Line 
1 and extends longer than 40 characters does not automatically continue on the next 
line. You must either press ENTER or click where you want the message to continue.

• Help - Click to open ShoreWare Wallboard Director Help.



Chapter 4: Communicating with Agents Supervisor User Guide

Contact Center 5.1 45

To create a new message:

Step 1 In the Messages Editor window, click New. 

All the fields become blank except for the Message Library.

Step 2 In the Message Name field, enter the name of the new message.

Step 3 In the Default Group field, from the drop down list, select the default group for the 
message (see the Parameter Group Assignment Rules section for details).

Step 4 In the work are, type the new message.

Step 5 If you need to add a parameter to the new message, place the cursor where you 
want the parameter to appear within the message, and click Parameter.

Step 6 When you have finished editing the message, in the Message Editor window, click 
OK to save the new message. The new message’s name appears in the Message 
Library.

When using the Message Area in the Message Editor, keep the following few rules in 
mind:

• To begin typing, position the cursor where you want to begin the message, and click 
the mouse.

• Clicking the spacebar on the keyboard inserts a small rectangle in the box 
(representing a space in the message). You cannot type another character in a box with 
a space rectangle until you delete the space.

• You can highlight a block of text and press either DELETE or BACKSPACE on the 
keyboard to erase the selected text.

• Parameters cannot be modified in any way, but you can remove them from, or add them 
to, existing messages.

To edit a preprogrammed message:

Step 1 In the Message Editor window, select the message that you want to edit from the 
Message Library.

Step 2 Make any corrections within the Message Editor or the Parameters window.

Step 3 When you have finished making the corrections, click OK. The changes are saved 
in the system.

To delete a message:

Step 1 In the Message Editor, click the message that you want to delete.

Step 2 Click Delete. 

A warning message appears.

Step 3 Click Yes to delete the message. 

The message is erased, along with all the information related to it.

Click No to cancel. Deleting a message removes it from any scenario in which it 
appeared.
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Adding Parameters to a Message
The messages displayed on the wallboard often contain important information that 
supervisors may want to convey to agents. This information can be taken from real-time 
reports by specifying a predefined parameter. Each message can have its own combination 
of parameters, which represent information in a group.

To add message parameters:

Step 1 Place the cursor where you want the parameter to appear within the message, and 
click Parameter. 

The Parameters dialog box opens.

Step 2 From the Group list, select one of the groups to which the selected parameter will 
refer (see the section Parameter Group Assignment Rules for details). 

Step 3 The Parameter list displays all the various parameters that can be added to a 
message. The Length field below the Parameter list indicates the maximum number 
of characters used to present the parameter’s value. To modify the displayed length, 
click the field and enter the required number.

Step 4 For example, you may have a message that informs the agents in the Sales group of 
their progress in answering calls. Click Sales in the Group field, and then select 
ASA from the list of parameters. This parameter indicates the Average Speed of 
Answer by the agents. Thus, when this parameter is included, a number indicating 
the ASA follows the message.

Step 5 To add the parameter to the message, click OK. 

The Parameters dialog box closes. The new or modified parameter is added to the 
message and displayed in the work area of the Message Editor in the form of 
paragraph marks. The number of paragraph marks reflects the number of 
characters the parameter will take on the wallboard (as defined in the Length field 
in the Parameters window).

If a message is assigned to a scenario or popup message, you can not add or delete 
parameters.
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From the Parameters List, you can select any of the following parameters to be included 
in your message.

• General Parameters

— Grp name - Use to display the name of the group.

• Currently in Queue

— Queue calls - Number of Incoming ACD calls waiting in the groups queue.
— Above T.ASA - Number of Incoming ACD calls waiting in the groups queue more 

than T.ASA seconds.
— Avg queue time - Average wait time of Incoming ACD calls waiting in the groups 

queue.
— Max queue time - Longest wait time of Incoming ACD calls waiting in the groups 

queue.
— STI 1 - STI 6 - One more step in the STI will be the target ASA, to see how many 

calls wait more than the target ASA.

• Information For Now

— Agents - Number of logged in agents.
— Rls agns - Number of agents in release state.
— Wr-Up agns - Number of agents in wrap-up state.
— Idle agns - Number of agents in idle state.
— ACD agns - Number of agents on an ACD call.
— Non-ACD agns - Number of agents on a non-ACD call.
— Too long talk - Number of agents who have been on a call for too long.
— Max talk time - Longest ACD call talk time (min:sec)

• On The Current Time-Interval

— TSF - The TSF for the current time-interval
— Inc calls - Number of Incoming ACD Calls
— Ansd calls - Number Of Answered ACD Calls
— % ansd calls - Percentage Of Answered ACD Calls out of all incoming ACD calls
— Abnd calls - Number Of Abandoned Calls
— % abnd calls - Percentage Of Abandoned Calls out of all incoming ACD calls
— Avg time abnd - Average Wait Time Of Abandoned Calls (sec)
— Max time abnd - Longest Wait Time Of Abandoned Calls (sec)
— Intrfl out - Number Of Calls Interflowed From Group
— % Intrfl calls - Percentage Of Calls Interflowed From Group out of all incoming 

ACD calls
— Avg calls in que - Average Number of Calls in Queue
— Avg time Intrfl - Average Wait Time Of Calls Interflowed From Group (sec)
— Max time Intrfl - Longest Wait Time Of Calls Interflowed From Group (sec)
— Intrfl in - Number Of Calls Interflowed To Group
— % Intrfl in - Percentage Of Calls Interflowed To Group out of all incoming ACD 

calls
— RPH - The Groups RPH. Calculated as the number of answered calls divided by the 

average number of agents, thus giving the average number of calls answered by an 
agent of the group

— Avg que time on - Average Wait Time In Queue (sec)
— Max que time on - Longest Wait Time In Queue (sec)
— Avg ACD talk on - Average ACD Talk Time (min:sec)
— Max ACD talk on - Longest ACD Talk Time (min:sec)
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— ASA - Average Answer Time (sec)
— RQD agns - Required Number of Agents In Order To Meet The Target-ASA
— T ASA - Not a statistical parameter but displays the target ASA for the group as 

defined by the administrator

• On The Previous Time-Interval

— Intrfl LP - Number of Calls Interflowed Last Period
— TSF LP - The TSF for the Last Period
— RQD agns LP - Required Number of Agents in Order to Meet the Target-ASA in 

Last Period
— Abnd LP - Number of Abandoned Calls in Last Period

Changing the Message Colors
ShoreWare Wallboard Director supports multiple background and foreground colors 
(foreground color is the text color). The Message Editor window enables you to change 
these colors.

To change the colors:

Step 1 In the work area of the Message Editor, highlight the area on which to apply the 
color changes.

Step 2 In the work area, right-click the mouse. The Select Colors window opens.

Step 3 Select a color from the color boxes. The options are:

• Blue - Background is blue; text is yellow
• Yellow - Background is yellow; text is blue
• White - Background is white; text is black
• Red - Background is red; text is black
• Green - Background is green; text is black

To set the blink option (that is, the text will blink on the wallboard), select the Blink check 
box.
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Parameter Group Assignment Rules
For any parameter in any message, a group must be assigned to be displayed. The 
parameter’s group may be defined in various stages during the process of inserting a 
message into a scenario or pop-up:

• In the Add/Edit message to scenario/pop-up dialog box, there is an option to assign the 
parameter to a specific group, for each parameter in the message. 

• In the Add/Edit message to scenario/pop-up dialog box, there is also an option to define 
a default group that, if defined, is used for every parameter that has no group assigned 
in the previous stage.

• In the Message Editor, in the Select Parameter dialog box, there is an option to assign 
the parameter to a specific group. This assignment is used if no assignment was made 
in one of the previous options.

• In the Message Editor, there is an option to define a default group for the message. This 
group is used for every parameter that was not assigned to a group in any of the 
previous stages.

The Wallboard Window
The Wallboard window enables you to add and remove wallboards and to “run” the 
scenario or pop-up when the message changes. The Wallboard window contains three tabs: 
Config, Scenario, and Pop-Up. 

Config Tab
The Config tab is used to define the communication parameters of the selected wallboard. 
You can create a single wallboard for all your agents, or individual wallboards targeted to 
specific agents (up to 256 separate wallboards). 

Some Spectrum wallboards support narrow fonts. You can use narrow fonts with these 
wallboard by adding the following statement to the wecc.ini file (located in the 
ShoreTel\Contact Center\Supervisor directory):

[RBE]
Narrow_mode = 1

Wallboards are created and edited using the following fields and buttons in the Wallboard 
window Config Tab.
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• Name - Displays the name (up to 32 characters) of the selected wallboard.

• Lines - The number of lines in the wallboard.

• Type - Drop-down list containing the following options to select the type of wallboard 
currently being used:

— AgentBoard: - No actual wallboard. The messages appear on the agent’s computer 
using the Agent Board application.

— Comfuture - This wallboard conforms to the comfuture wallboard protocol.

— Spectrum / Alpha - This wallboard conforms to the Spectrum wallboard protocol. 

• Address- Contains the address of the wallboard connected to the COM port. When 
using chained wallboards, each wallboard must use a different address.

• Com Port - Click one of the option buttons in this area to define the com port to which 
the wallboard is connected.

• Threshold Colors - Thresholds are specific event values that, if exceeded, are marked 
by special colors. These colors are used in the wallboard to show values that have 
exceeded the threshold values. The color on the right indicates that the threshold of 
calls is almost reached and could become a problem. The color on the left indicates that 
the threshold has been surpassed and a major problem is at hand. You can change the 
colors by double-clicking the mouse button and using the Select Colors window.

• Save - Saves the data choices that have been entered and return to the wallboard main 
window.

• Cancel: Undo any actions you performed or any new data you have entered. You will 
return to the previous window without saving any changes.

To create a new wallboard:

Step 1 Click New. 

Step 2 In the Name field, enter the name of the new wallboard.

Step 3 Enter the information in the other configuration fields (see above).

Step 4 From the Scenario and Pop-Up windows, create the new wallboard message 
scenario.

Step 5 Click Save.

Changing Threshold Colors
Thresholds are specific event values that, if exceeded, are marked by special colors. These 
colors are used to show values that have exceeded the threshold values. Two colors are used 
to signify that a parameter has exceeded its threshold. The default colors are yellow and 
red.

To change the threshold colors on the wallboard:

Step 1 In the Wallboard window, click the Config tab. 

Step 2 In the Threshold Colors field, double-click the color you want to change.

Step 3 Select a color from the color boxes. The options are
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• Blue - Background is Blue; text is Yellow
• Yellow - Background is Yellow; text is Blue
• White - Background is White; text is Black
• Red - Background is Red; text is Black
• Green - Background is Green; text is Black

Step 4 Select the Blink check box to set the blink option (that is, the text will blink on the 
wallboard).

Scenario Tab
The Scenario tab is used to define the message scenario for the selected wallboard. A 
message scenario is a sequence of messages. Each message within the scenario is displayed 
on the wallboard for a specific amount of time. The Scenario tab is used to build or modify 
message scenarios for the wallboards.

The Message Library lists all the messages created in the Message Editor. The Scenario 
Table, on the right-hand side of the window, contains the names of the messages (in order 
of appearance) and the display time (in seconds).

The six buttons on the tab allow you to edit the scenario as follows:

• Up arrow - Moves the selected message up within the message scenario.

• Down arrow - Moves the selected message down within the message scenario.

• Add - Opens the Add Messages to the Scenario window and add a message to the 
message scenario.

• Edit - Edits the selected message within the scenario; for example, to change the 
amount of time the message will be displayed or to change the group to which the 
message is directed. The Edit Message window opens.

• Remove - Removes a selected message from the Scenario Table. Note: The message is 
not removed from the Library.

• Message Editor - Opens the Message Editor and edit the selected message.
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To create a message scenario:

Step 1 Click the wallboard for which you want to create a scenario from the list in the 
Wallboard window, and click the Scenario tab. 

Step 2 In the Message Library, select a message to be added to the message scenario, and 
click Add.

The Add Message window opens. 

Step 3 In the Time field, enter the amount of time, in seconds, that you want the message 
to appear on the wallboard.

Step 4 In the Default Group field, enter the appropriate group. 

This group will be used for any parameter not specifically assigned a group in the 
next step.

Step 5 Using the up and down arrows, select a parameter in the Param # field. 

Note that the selected parameter is highlighted in the message area, and the 
parameter’s name appears in the Name field.

Step 6 Change the Group assignment for this field. Continue to do this until you are 
satisfied with the parameters and their respective groups.

If you have decided to skip one field and not to assign a group for it, this parameter 
will display values related to the default group selected in Step 4 of this procedure.

Step 7 After all the information has been entered, click OK to include the message in the 
scenario.

Repeat Steps 2–7 until all the required messages are included in the scenario. A 
message can be used more than one time in a scenario.

To change the position of a message within the scenario, Click the message in the 
scenario, and use the Up/Down arrow buttons to either promote or demote the selected 
message.

Add/Edit Message in a Scenario Dialog Box
The Add/Edit Message dialog box is displayed when you click the Add/Edit buttons in the 
Wallboard window in the Scenario tab.
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The Add/Edit Message in a scenario dialog box comprises:

• Time - The time, in seconds, that the message appears on the wallboard.

• Default Group - The default group is automatically assigned to every parameter in the 
message not assigned to a specific group.

• Param # - Use this section to assign a parameter to a group other than the default 
group. Use the up and down arrows to select a parameter, and then change its 
assignment to a group using the Group list box.

• Name - Displays the selected parameter name.

• Group - Changes the assignment of the selected parameter to a different group.

Pop-Up Tab
The Pop-Up tab is used to define the pop-up for the selected wallboard. A pop-up is a 
message that appears at a specific date and time or at specific time intervals. The Pop-Up 
tab enables you to define when and how these messages are shown on the wallboard.

The Messages Library lists all the messages created in the Message Editor. The Pop-Up 
table, on the right-hand side of the window, contains the message names and the date and 
time of their appearance.

Four buttons enable you to edit the Pop-Up window, as follows:

• Add - Adds a selected message to the pop-up list on the right-hand side of the window. 
The Add Message window opens.

• Remove - Removes a selected message from the pop-up list.

• Message Editor - Opens the Message Editor and edit the selected message.

• Edit - Edits the selected pop up message within the scenario (for example, to change 
the amount of time or the intervals that the message will be displayed).

To insert a pop-up message to a scenario:

Step 1 In the Pop-Up tab, select a message to add to the Pop-Up scenario from the 
Message Library.

Step 2 Click Add.
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The Add Pop-Up Message window opens. (This window is identical to the Edit 
Pop-Up Message window, except that the latter displays the parameters of the 
message you want to edit.)

Step 3 In the From Date field, enter the date when the message is to start appearing on the 
wallboard. 

The date must be entered in the MM/DD/YY format.

Step 4 In the To Date field, enter the date when the message is to stop appearing on the 
wallboard. 

The date must be entered in the MM/DD/YY format.

Step 5 In the From Time field, enter the time when the message is to start appearing on 
the wallboard. 

The time must be entered in the 12 hour format (AM/PM).

Step 6 In the To Time field, enter the time when the message is to stop appearing on the 
wallboard. 

The time must be entered in the 12 hour format (AM/PM).

Step 7 In the Day of the Week area, click the days of the week when you want the pop-up 
message to appear.

Step 8 There are two ways to add a pop-up message: Concatenate to Scenario or Wipe 
Out. In the Concatenate to Scenario mode, the message is incorporated into the 
message scenario for the indicated amount of time. In the Time field, enter the 
exact length of time that the message should appear in the scenario. In the Wipe 
Out mode, the pop-up message overrides the scenario for the length of time that 
the message should appear. This type of pop-up message appears for the specific 
amount of time defined in the Time field and according to every time that was 
predefined in the every field. If two pop-up messages, defined by the Wipe Out 
method, are configured to appear at the same time, the message with the higher 
priority (as defined in the Priority field) will display.

Step 9 In the Default Group field, enter the appropriate group. 

This group will be used for any parameter not specifically assigned a group in the 
next step.

Step 10Using the up and down arrows, select a parameter in the Param # field. 

Note that the selected parameter is highlighted in the message area, and the 
parameter’s name appears in the Name field.

Step 11You can now change the Group assignment for this field. Continue to do this until 
you are satisfied with the parameters and their respective groups.

If you have decided to skip one field and not to assign a group for it, this parameter 
will display values that are related to the default group selected in Step 4 of this 
procedure.
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Add/Edit Pop-Up Message Dialog Box
The Add/Edit Pop-Up Message dialog box is displayed when you click the Add/Edit 
buttons in the Wallboard window in the Pop-Up Tab.

The Add/Edit pop-up Message dialog box comprises:

• From Date/To Date - Select the date range in which the pop-up will be activated.

• From Time/To Time - Select the time range in which the pop-up will be activated.

• Day of Week - Select the Days Of Week in which, within the date range, the pop-up 
will be activated.

• Method - Use this area to select between two possible modes for the pop-up:

— Concatenate to scenario - In this mode the pop-up message is added to the scenario 
as if it were part of the scenario. It does not replace the scenario messages but is 
added in between.

— Wipe Out - In this mode, the pop-up message is displayed cyclically (the cycle time 
is defined by the Every parameter) for the duration defined by the Time parameter. 
When the pop-up message is displayed, it replaces the currently “supposed to be 
displayed” message. If two pop-up messages should be displayed simultaneously, 
the one with the highest priority will be actually displayed.

• Default Group - The default group is automatically assigned to every parameter in the 
message not assigned to a specific group.

• Param # - Use this section to assign a parameter to a group other then the default 
group. Use the up and down arrows to select a parameter, then change its assignment 
to a group using the Group list box.

• Name - Displays the selected parameter name.

• Group - Changes the assignment of the selected parameter to a different group.
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